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USER GUIDE

SCC-CI20 Current Input Module

The SCC-CI20 converts current to voltage by passing it through a precision
249 Qresistor and sending the resulting voltage to the E Series DAQ device
as a 0 to +5 V signal. The SCC-CI20 accepts up to two current sources at a
maximum of 20 mA. A differential instrumentation amplifier buffers each
input signal.

Conventions

The following conventions are used in this guide:

<> Angle brackets that contain numbers separated by an ellipsis represent
a range of values associated with a bit or signal name—for example,
P1.<3..0>.

» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

> &

ﬁ When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

é When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select in software, such as menu
items and dialog box options. Bold text also denotes parameter names.
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italic

monospace

SC-2345

ScC

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and configurable
connector.

SCC refers to any SCC Series signal conditioning module.

What You Need to Get Started

To set up and use the SCC-CI20, you need the following items:

U SC-2345/2350 with one of the following:
—  SCC-PWRO1
—  SCC-PWRO02 and the PSO1 power supply

—  SCC-PWRO03—requires a 7 to 42 VDC power supply
(not included)

One or more SCC-CI20 modules

SC-2345/2350 User Manual, available at ni . com

SCC-CI20 Current Input Module User Guide

SCC Quick Start Guide, available at ni . com

Read Me First: Safety and Radio-Frequency Interference
SC-2345 Quick Reference Label

68-pin E Series DAQ device, documentation, and 68-pin cable
1/8 in. flathead screwdriver

Numbers 1 and 2 Phillips-head screwdrivers

Wire insulation strippers

0O UOUoUOUUOULUOLUULULU

NI-DAQ (current version) for Windows 2000/N'T/XP/Me

SCC-CI20 Current Input Module User Guide 2 ni.com



@ Note Software scaling of measurements is not supported on the Macintosh operating
system. Refer to the Specifications section for more information.

Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2350 carrier, refer to the SCC Quick Start Guide, available for
download at ni . com/manuals.

Installing the Module

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

You can plug the SCC-CI20 into any analog input socket on the SC-2345.
It can function either as a single-stage module or as the first stage of a
dual-stage signal conditioning configuration. The socket you choose
determines which E Series DAQ device channels receive the SCC-CI20
signals.

For single-stage input conditioning, plug the SCC-CI20 into any socket
J(X+1), where X is O to 7, and connect the input signals to the module as
described in the Connecting the Input Signals section.

If you use the SCC-CI20 in a dual-stage configuration, you must use it as
the first stage. Plug the SCC-CI20 into any socket J(X+9) and plug the
second-stage SCC into socket J(X+1), where X is O to 7. Connect the input
signals to the SCC-CI20 as described in the Connecting the Input Signals
section. The SC-2345 connects the output signals of the SCC-CI20 to the
inputs of the second-stage SCC. One example of a second-stage module
compatible with the SCC-CI20 is a lowpass filter module (SCC-LPXX).

Sockets J9 to J16 are also available for digital input/output (DIO)

conditioning or control. Refer to the SC-2345/2350 User Manual for more
information on configuring, connecting, and installing SCC modules.

Connecting the Input Signals

@ Note The signal names have changed. Refer to ni . com/info and enter rdtntg to
confirm the signal names.

Each screw terminal is labeled by pin number <1..4>. Pins 1 and 2 form a
differential channel routed to E Series DAQ device channel X+8, and pins
3 and 4 form a second differential channel routed to E Series DAQ device

© National Instruments Corporation 3 SCC-CI20 Current Input Module User Guide



channel X. The value of X is determined by the number of the SC-2345
socket, J(X+1) or J(X+9), where you plug in the SCC-CI20. Figure 1 shows
the SCC-CI20 signal connections.

10 MQ

signal  SCCC120 ] E Series DAQ Device
Source 4.+ _ | Overvoltage v ;
Protection 1
= GAeo
Overvoltage
s - Protection v !
j :+ AlGND |
25 o | Overvoltage i |
e Protection b .
L AL(X+8) ;
Overvoltage ; I ;
Protection o '

- . .
<.~/ Signal source may be floating or ground-referenced.

Figure 1. SCC-CI20 Signal Connections

The input signal source can be floating or ground-referenced. The
SCC-CI20 has high-impedance bias resistors typically required for floating
sources, so you do not need external bias resistors referenced to ground.

Replacing the Input Resistors

Incorrect connections can damage the input resistors and possibly other
components of the module. Spare 249 Q resistors are available inside the
SCC-CI20. To open the SCC-CI20, complete the following steps:

1. Remove the screw from the back (wide unlabeled side).
2. Turn the front (wide labeled side) toward you.

3. Place the screw-terminal receptacle to the left.

4. Slide the top cover to the right.

5. Lift off the cover.

SCC-CI20 Current Input Module User Guide 4 ni.com



The input resistors are socketed so that you can replace them when
necessary. Figure 2 shows the locations of the input and spare resistors.

c40 Gu SSMBNLB 01
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- Tu 0000000000
O oo 050 S
gera RTRN RT3

1 Input Resistor for Al (X) 4 Spare Resistors
2 Product Name 5 Input Resistor for Al (X+8)
3 Assembly Number

Figure 2. SCC-CI20 Parts Locator Diagram

For information about how to configure the SCC-CI20 module using
NI-DAQmzx, refer to the SCC Quick Start Guide.

Using the SC-C120 when Scaling Voltage Measurements

If you configured the SCC-CI20 using Measurement & Automation
Explorer (MAX) and you are using NI-DAQ, the reading you get from the
E Series DAQ device accounts for the voltage-to-current conversion and
returns milliamps, not volts. Otherwise you must convert the raw voltage
measurement to a current measurement. To make this conversion, use the
following formula:

where [ is in milliamps and V is in volts.
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Specifications

These ratings are typical at 25 °C unless otherwise stated.
Analog Input

Number of input channels.........c.cc..c...... 2 DIFF

INput range .......cecvevveerenvecienieneeeeneene 0to 20 mA

Input resistor

Value..coooviiiiiiiiiiiiicciccee, 249 Q

Tolerance ........cceeveeeveeeveennieenieeneene 0.05%

Temperature coefficient

Of TeSIStANCE ...veeeveeevieieeieeeeeeee 10 ppm/°C

Maximum power dissipation ........... 025W
Maximum input current............c.ccocoeeueeee 32 mA
OULPUL TANEZE ..ovvveenveeeieeieeire e Oto+5V
Output Slew rate.........ccoceeeeerereeerieeciennenns 0.75 V/us min
GAIN EITOT ... 40.1% max!
Temperature stability of gain error......... 10.006%/°C max
OffSEt €ITOT .vevvevreveieieieieieieiee e 0.6 mV max!
Temperature stability of offset error....... +21 pV/°C max

Dynamic Response
Bandwidth (-3 dB, amplitude <4 mA)...10 kHz

Output SIew rate......cocceevveeveerveeeneennennne 0.75 V/us min

I Temperature range is 23 °C + 5 °C.
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Power Requirement

ANalog POWET ....cveevveiiriineeieeeene e 100 mW max
FISV o 3.2 mA max
15 Ve 3.2 mA max

Digital power (+5 V) ...oooeeiiviniincneee. 0.0 mW

Operating voltage range

FISV e +10%
15V e +10%
Physical
Dimensions..........ccoevvvveeeeeeniiveeeeeeeineeeeen. 8.89cm x2.92cm x 1.85 cm

(3.501in. x 1.15 in. X 0.73 in.)

I/O connectors...........ccooeeeeerecniiiencnnen. One 20-pin right-angle
male connector,
one 4-pin screw terminal

Wire gauge range ........ccoeeveeveeeeveenreennnenn 28to 16 AWG

Maximum Working Voltage

Maximum working voltage refers to the signal voltage (I X 249 Q) plus the
common-mode voltage.

Channel-to-earth...........cccccceeivencnnnne. +15 V, Installation Category 1

Channel-to-channel ..........cccccovernnenee. +15 V, Installation Category 1
Environmental

Operating temperature. .............cceeeeueenne. 0to 50 °C

Storage temperature .........cceceeervveerveennnen. —20to 70 °C

Humidity ....oooevvenieiiieiiiieiecieeeeen 10 to 90% RH, noncondensing

Maximum altitude ..........oooevvevvvveeeennen. 2,000 m

Pollution Degree (indoor use only)........ 2
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Safety

The SCC-CI20 is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« IEC61010-1, EN 61010-1
e UL3111-1,UL 61010B-01
« CAN/CSA C22.2 No. 1010.1

@ Note For UL and other safety certifications, refer to the product label, or visit
ni.com/hardref .nsf, search by model number or product line and click the appropriate
link in the Certification column.

Electromagnetic Compatibility

EmiSSiONS...ccuvvviiieiiiiieeeeeeiieeeee e EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMMUNItY ..oooeeeiiiieeeeeee EN 61326:1997 + A2:2001,
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

@ Note For EMC compliance, operate this device with shielded cabling.

CE Compliance

This product meets the essential requirements of applicable European
directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety).............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMOC) ...cccoevvevvevenineecncnnenne. 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/hardref .nsf, search by model number or product line, and click the
appropriate link in the Certification column.
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SCC-CI20 Module Pin Assignments

Figure 3 shows the I/O connector pins on the bottom of the module.

/@

(CHONONONONONONONONG)
Q000000000 @
A .4

1 Pin 1 2 Pin2 3 PWB Key 4 Pin19 5 Pin 20 |

Figure 3. SCC Module Bottom View

Table 1 lists the signal connection corresponding to each pin. Al (X) and
Al (X+8) are the analog input signal channels of the E Series DAQ device.
AI GND is the analog input ground signal and is the reference for Al (X)
and AI (X+8). A GND is the reference for the =15V supplies. Al GND and
A GND connect to the SC-2345 at the SCC-PWR connector. Pins 17 to 20
accept signals from a first-stage module if you are cascading two modules.

Table 1. SCC-CI20 Pin Signal Assignments

Pin Number Signal

1 E Series Al (X)
2 E Series Al GND
3 —

4 E Series Al (X+8)
5 —

6 E Series AI GND
7 _

8 E Series AI GND
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Table 1. SCC-CI20 Pin Signal Assignments (Continued)

Pin Number Signal
9 —
10 —
11 E Series A GND
12 —
13 +15V
14 -15V
15 —
16 —
17 Al (X)— (from first stage)
18 Al (X+8)+ (from first stage)
19 Al (X)+ (from first stage)
20 Al (X+8)— (from first stage)

National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of National Instruments
Corporation. Product and company names mentioned herein are trademarks or trade names of their
respective companies. For patents covering National Instruments products, refer to the appropriate
location: Help»Patents in your software, the patents . txt file onyour CD, orni . com/patents.

© 2001-2004 National Instruments Corp. All rights reserved.
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